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Dies ist ein rechtsgültiger Vertrag zwischen Ihnen, dem Endanwender, und Testo. Wenn Sie oder eine von
Ihnen bevollmächtigte Person die versiegelte CD-ROM-Verpackung öffnet, erkennen Sie die
Bestimmungen dieses Vertrages an. Wenn Sie mit den Bedingungen nicht einverstanden sind, geben Sie
das ungeöffnete Softwarepaket mit den Begleitgegenständen, einschließlich aller schriftlichen Unterlagen
und sonstigen Behältnissen, unverzüglich gegen volle Rückerstattung des Preises an die Stelle zurück, von
der Sie das Softwarepaket bezogen haben.

Einräumung einer Lizenz
Diese Lizenz gibt Ihnen die Berechtigung, eine Kopie der Testo-Software, die mit dieser Lizenz erworben
wurde, auf einem Einzelcomputer unter der Vorraussetzung zu benutzen, dass die Software zu jeder
beliebigen Zeit auf nur einem einzigen Computer verwendet wird. Wenn Sie Mehrfachlizenzen für die
Software erworben haben, dürfen Sie immer nur höchstens so viele Kopien in Benutzung haben wie Sie
Lizenzen haben. Die Software ist auf einem Computer ”in Benutzung”, wenn sie in den Zwischenspeicher,
d.h. RAM geladen oder in einem Permanentspeicher, z.B. einer Festplatte dieses Computers gespeichert
ist, mit der Ausnahme, dass eine Kopie, die auf einem Netz-Server zu dem alleinigen Zweck der Verteilung
an andere Computer installiert ist, nicht ”in Benutzung” ist. Wenn die vorraussichtliche Zahl der Benutzer
der Software die Zahl der erworbenen Lizenzen übersteigt, so müssen Sie angemessene Mechanismen
oder Verfahren bereithalten, um sicherzustellen, dass die Zahl der Personen, die die Software gleichzeitig
benutzen, nicht die Zahl der Lizenzen übersteigt.

Urheberrecht
Die Software ist durch Urheberrechtsgesetze, internationale Verträge und andere Rechtsvorschriften
gegen Kopieren geschützt. Sie dürfen weder die Software noch die Handbücher des Produktes noch
andere schriftliche Begleitpapiere zur Software kopieren. Die Software darf nicht weiter lizenziert, vermietet
oder verleast werden. Wenn die Software nicht mit einem technischen Schutz ausgestattet ist, dürfen Sie
entweder eine einzige Kopie der Software ausschließlich für Sicherungs- oderArchivierungszwecke
machen oder die Software auf eine einzige Festplatte übertragen, sofern Sie das Original ausschließlich
für Sicherungs- oder Archivierungszwecke aufbewahren. Zurückentwickeln (Reverse engineering),
Dekompilieren und Entassemblieren der Software sind nicht gestattet. Sie können für jede Verletzung der
Schutzrechte, die Sie oder eine von Ihnen bevollmächtigte Person zu vertreten haben, von der Testo AG
Lenzkirch in Anspruch genommen werden.

Beschränkte Garantie
Testo garantiert für einen Zeitraum von 90 Tagen ab Erwerb der Software durch den Käufer oder für einen
längeren Mindestzeitraum, wenn ein solcher in den Gesetzen des Landes vorgeschrieben ist, in dem das
Produkt verkauft wird, dass die Software allgemeinen, in der Begleitdokumentation definierten Standards
entspricht. Testo gewährleistet ausdrücklich nicht, dass die Software ohne Unterbrechung oder ohne
Fehler abläuft. Sollte die Software bei normaler Benutzung nicht gemäß der Begleitdokumentation
funktionieren, hat der Käufer das Recht, die Software innerhalb der Gewährleistungsfrist an Testo
zurückzusenden und Testo schriftlich von der mangelnden Funktionsfähigkeit zu benachrichtigen. Testo ist
nur dazu verpflichtet, dem Käufer innerhalb eines angemessenen Zeitraums nach Erhalt der
Benachrichtigung über die Funk-tionsunfähigkeit eine funktionsfähige Kopie der Software zur Verfügung zu
stellen oder, sollte eine Kopie aus irgendeinem Grund nicht verfügbar sein, dem Käufer den Kaufpreis
zurückzuerstatten.

Jegliche über die oben dargelegte beschränkte Garantie hinausgehende Gewährleistung bezüglich der
Software, der zugehörigen Handbücher und schriftlichen Materialien wird ausgeschlossen.

Weder Testo noch die Lieferanten von Testo sind für irgendwelche Schäden ersatzpflichtig, die aufgrund
der Benutzung dieses Testo-Produktes oder die Unfähigkeit dieses Testo-Produkt zu bedienen entstehen,
selbst wenn Testo von der Möglichkeit eines solchen Schadens unterrichtet worden ist. Dieser Ausschluss
gilt nicht für Schäden, die durch Vorsatz oder grobe Fahrlässigkeit seitens Testo verursacht wurden.
Ebenfalls bleiben Ansprüche, die auf unabdingbaren gesetzlichen Vorschriften zur Produkthaftung
beruhen, unberührt.

Copyright © 2001 by Testo AG

Microsoft®, Windows® und Excel® sind eingetragene Warenzeichen der Microsoft Corporation

Lizenzvereinbarung
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Die Software Comsoft 3 dient zum Speichern, Auslesen
und Auswerten von Einzelmesswerten und Messreihen. Die
graphische Darstellung der Messwerte ist die
Hauptaufgabe dieses Programms.
Messwerte werden mit Testo Messgeräten gemessen und
über die serielle Schnittstelle an den PC übertragen.
Das Auslesen erfolgt mit Hilfe der Software ComSoft 3, die
die Schnittstellen aktiviert und alle Funktionen bereitstellt.

Für jedes Testo-Gerät / -System gibt es zur Installation
passende Gerätetreiber, diese sind speziell auf den
Leistungsumfang der Gerätehardware und deren
Bedienung abgestimmt.

Erfasste Messwerte werden mit Datum und Uhrzeit
protokolliert. Bei ONLINE-Messvorgängen werden die
Werte ständig aktualisiert.

Bestimmungsgemäßer Gebrauch

Vorbereitung
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Mindest - Systemvoraussetzungen
• PC mit Betriebsystem

- Microsoft Windows 95 oder höher (falls kompatibel)
- Microsoft Windows NT 4, Servicepack 4, oder höher 

(falls kompatibel).
- Windows 2000 oder höher (falls kompatibel).

• CD-Rom-Laufwerk
• Pentium 100 MHz
• 32 MB RAM
• 15 MB Festplattenplatz frei
• Freie serielle Schnittstelle (COM) oder entsprechender

Adapter.

Installationsvorgang
1. CD-ROM in das Laufwerk einlegen

2. Nach kurzer Zeit startet das Installations-Menü
selbsttätig. Falls nicht, bitte „Setup.EXE“ auf der CD-
ROM doppelklicken.

3. Sie werden aufgefordert die Lizenznummer einzugeben
(siehe Aufkleber auf CD-ROM).
Bei Erstinstallation ist ggf. ein Neustart notwendig.
Hinweis: wird die eingegebene Nummer nicht akzeptiert, 
- ist versehentlich die Feststelltaste gedrückt?
- ist bei separatem Zahlenblock “Num” nicht aktiv?
- wurde statt 1 versehentlich l eingegeben?
- wurde statt 0 versehentlich o eingegeben?

4. Mit der Bestätigung wird der Installationsvorgang
menügesteuert fortgesetzt. Bitte beachten Sie die
Hinweise und Erläuterungen neben den Schaltflächen.

Installation

Vorbereitung
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Allgemeine Kenntnisse für die Benutzung und
Installation der Software
Die Softwareoberfläche (das Erscheinungsbild, die
Bedienphilosophie ) ist nach dem Microsoft® Office-
Standard definiert. Symbole und Menüpunkte sind analog
zu diesem Standard gewählt. Wenn Sie also bereits mit
Office-Programmen (Word®, Excel®, PowerPoint® ...)
arbeiten, werden Sie sehr schnell mit der Oberfläche
vertraut sein.

Vorbereitung
Installation
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1st Session – eine Kurzanleitung

Zur einfachen Bedienung der Software sind bestimmte
Menüfunktionen direkt über die Maus zu erreichen.
Ein einmaliges Betätigen der jeweiligen Maustaste wird als
„Klick“, ein zweimaliges Betätigen als „Doppelklick“
bezeichnet.

Abhängig vom entsprechenden Programmschritt ergeben
sich folgende Möglichkeiten:

Klick links auf 
Menüpunkt: Öffnet Untermenü oder 

führt Funktion aus

Klick links auf 
Symbolbutton: führt Funktion aus

Klick links auf 
Name in Datenbereich: wählt aus

Doppelklick links: wählt aus und öffnet/führt aus

Klick rechts: öffnet Kontextmenü 
(wenn vorhanden)

Mausfunktionen 
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Symbolleiste

1st Session - eine Kurzanleitung

Mit den in der Symbolleiste zusammengefaßten Icons
(Symbolen) können Sie oft benötigte Befehle direkt
ausführen.

Kategorie Gerät

Datei öffnen

Aktives Dokument speichern

Ansicht drucken

Seitenansicht 

In die Zwischenablage kopieren

Inhalt der Zwischenablage einfügen

Hilfe verwenden

Situationsbezogene Hilfe anwenden
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Symbolleiste

1st Session - eine Kurzanleitung

Kategorie Gerät

Gerätesteuerung

Online-Messung starten

Online-Messung stoppen

Kategorie Ansicht

Ansicht als Diagramm

Ansicht als Tabelle

Linke Maustaste vergrößert

Linke Maustaste zeigt Fadenkreuz

Schriftart wählen
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Menüleiste

1st Session – eine Kurzanleitung

Die Menüleiste enthält von links nach rechts folgende
Einträge:

Datei
Alle Funktionen, die man zum Öffnen, Schließen,
Speichern, Löschen und Drucken benötigt. In diesem Menü
kann das Programm auch beendet werden.

Gerät
Aus diesem Menü wird die Anbindung zu den Messgeräten
gesteuert. Neue Messgeräte können angeschlossen und
konfiguriert werden.

Bearbeiten
Hier befinden sich die Funktionen für das Kopieren und
Einfügen von Dateien.
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Ansicht
Hier liegen Funktionen, die die graphische Darstellung bzw.
den Bildschirmaufbau betreffen. Symbolleiste, Statuszeile
und der Datenbereich können ein/ausgeblendet werden.

Format
Hier können Einstellungen zum verwendeten Zeichensatz
vorgenommen werden. Dieser Zeichensatz wird dann für
die Messprotokolle und zum Beschriften von Diagrammen
verwendet.
Mit bestimmten Mustern kann das Aussehen von
Diagrammen und Tabellen optisch aufgewertet werden.

Fenster
Sind mehrere Dateien gleichzeitig im Arbeitsspeicher,
haben Sie hier mehrere Optionen für die Darstellung zur
Auswahl.

?
Über diese Menü kann die Hilfe aufgerufen und
Servicedaten angezeigt werden

Menüleiste

1st Session – eine Kurzanleitung
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Hierbei handelt es sich um eine Palette von Befehlen, die
für einen bestimmten Bereich speziell ausgewählt sind.
Abhängig von der Position des Mauszeigers werden durch
Klick rechts Befehle angeboten, die zum jeweiligen Kontext
passen.

Kontext-Menüs

1st Session – eine Kurzanleitung
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Online-Hilfe

Für viele Funktionen steht die Online-Hilfe zur Verfügung.
Sie aktivieren diese durch Drücken der F1 (Funktionstaste
auf der Tastatur) oder durch Anklicken des Menüs ? in der
Menüleiste.

Mit Umschalt+F1 erreichen Sie die Direkt-Hilfe. Der
Mauszeiger wandelt sich in ein Fragezeichen mit Pfeil um.
Damit klicken Sie auf den gewünschten Bereich. Zu diesem
Thema wird dann die Online-Hilfe geöffnet.

1st Session – eine Kurzanleitung
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Demo-Datei ohne Gerät

Um Messdatensätze graphisch darzustellen, müssen diese
geöffnet werden werden.

Ursprung für solche Datensätze ist der Speicher von Testo
Geräten oder ein Verzeichnis auf einem PC-Datenträger für
bereits archivierte Daten (hier: Demo-Files).

Nach Anwahl des Menüpunktes “Datei”, wird der
Menüeintrag “Öffnen” ausgewählt.

Daraufhin erscheint die Dialogmaske „Öffnen“.

Im oberen Teil der Dialogmaske kann ein Laufwerk oder ein
Ordner ausgewählt werden. Im mittleren Bereich erscheint
eine Liste mit Dateinamen. Welche Art der Dateien
angezeigt wird, kann mit „Dateityp“ festgelegt werden.

Verfügbar sind:
- *.vi2 Standard Dateien, erstellt unter 

ComSoft 3
- *.prn Dateien der Softwareversionen 

2.51 und älter, gespeichert
als ASCII - Textdatei

- *.WKS Dateien der Softwareversionen 
2.51 und älter, gespeichert als 
WKS

- *.* Alle Dateien.

Beispiel 1
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Hinweis: Ansichtsdateien von früheren Softwareversionen
(*.viw) werden von dieser Software nicht mehr unterstützt.

Die Demo-Files finden Sie in folgendem Verzeichnis:
“...\Datenbereich\Beispieldateien”

Ein Dateiname wird herausgepickt und durch Klick auf die
Taste „Öffnen“ geöffnet.
Durch Klicken auf eines der Symbole „Tabelle“ oder
„Diagramm“ kann gewählt werden, in welcher Form das
Messprotokoll dargestellt wird.

Diagramm

Tabelle

Demo-Datei ohne Gerät

Beispiel 1
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Demo-Datei ohne Gerät

Beispiel 1

Laden Sie eine Datei aus dem Ordner “Beispieldateien”
und probieren Sie die zur Verfügung stehenden Funktionen
aus:

Funktion Lupe
Ausschnittsvergrößerung

Durch Aufspannen eines Rechtecks im Diagrammfenster
(bei gedrückter linker Maustaste einen Rahmen innerhalb
des Fensters aufziehen) legt man neue Grenzen für den
dargestellten Bereich fest.
Diese Funktion ist auch während einer Messung im Online-
Betrieb erreichbar. Dabei wird jedoch der angezeigte
Ausschnitt stets den aktuellen Wert anzeigen.

Bei Klicken der Schaltfläche „Originalgröße“ wird das
Diagramm wieder in seiner gesamten Größe dargestellt.
Alle Ausschnittsvergrößerungen werden so rückgängig
gemacht.

Funktion „Fadenkreuz“
Picken Sie eine Messkurve, um ein Fadenkreuz
darzustellen, welches dem Werteverlauf folgt. Gleichzeitig
werden Messwertnummer, Datum, Zeit und Messwert in
einem Fenster dargestellt.

Funktion „Muster bearbeiten“
Diese Funktion finden Sie im Menü “Format”.
Sie dient in Diagrammen zum Einstellen von Hintergrund-
und Gitternetzlinienfarbe, sowie zum Ändern der Linienart
des Gitternetzes.
Sie dient in Tabellen zum Markieren von Grenzwerten.
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Demo-Datei ohne Gerät

Beispiel 1

Beginnen Sie mit einem Klick auf die jeweilige Kurve, und
passen Sie zuerst die Linienstärke und das Muster an,
glätten Sie die Kurve und markieren Sie ggf. die
Messpunkte.

Definieren Sie unter “Datenreihe” die notwendigen
Grenzwerte sowie deren Darstellung unter
“Grenzwertanzeige”.

Im Menü Format finden Sie unter “Muster” die
Änderungsmöglichkeit von Hintergrund- und
Gitternetzlinien.
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Beispiel 1

Bearbeiten Sie die Zeitachse:

Nach Doppelklick oder Klick rechts auf die Zeitachse
können Sie Auflösung, Start und Ende des
Darstellungsfensters einstellen.

- “Relativ” setzt die Startzeit zu 00:00, die Zeit
läuft dann relativ zu dieser Startmarke.

- “Ausschnitt” setzt einen fest definierten Rahmen,
der über die Zeitachse verschoben werden
kann.

- “Fensterlage” setzt einen fixen Ausschnitt.
- “Teilung” legt die Wiederholfrequenz der

Gitternetzlinien fest.

Optimieren Sie den Wertebereich / Y-Achse:
Für eine bessere Übersicht lohnt es sich, den Wertebereich
für die jeweilige Kurve selbst zu skalieren, Sie kommen in
das Menü durch Doppelklick oder Klick rechts auf die Y-
Achse. Die Teilungsdichte können Sie über die Pfeiltasten
einstellen oder über “manuell” direkt eingeben.

Demo-Datei ohne Gerät
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Beispiel 1

Demo-Datei ohne Gerät

Messdaten drucken
Messdaten können in Diagramm- oder Tabellenform auf
den Drucker ausgegeben werden. Gedruckt wird ein
Formblatt bestehend aus:

• Protokollkopf mit 
- Titel (Datei- oder Gerätenamen), 
- Datum,
- Start- und Endzeit einer Messung (nur Tabellen),
- Kanal- und Messwertanzahl (nur Tabellen),
- laufender Seitennummer,
- der Eingabemöglichkeit von „Bedingungen“,
- weiteren zusätzlichen Kommentarzeilen.

Beim Ausdrucken enthält der Protokollkopf Informationen
über das gesamte Messprotokoll.

Beim Tabellendruck verwenden Sie am besten Hochformat,
zum Diagrammausdruck empfiehlt sich Querformat. Das
Format stellen Sie mit dem Menü “Seite einrichten” ein.
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testo 174: Daten auslesen, Diagramm
bearbeiten und Daten speichern

Beispiel 2

Zur Einrichtung einer Verbindung zwischen Datenlogger
und Software, sowie zur Programmierung des
Datenloggers lesen Sie bitte die Bedienungsanleitung zum
Datenlogger.

Legen sie einen Datenlogger der Werte gespeichert hat in
das Interface.

Durch Doppelklick auf das Gerät im Datenbereich wird die
Verbindung hergestellt. Unter dem Gerät erscheint das im
Gerät gespeicherte Protokoll.

Durch Doppelklick auf das Protokoll werden die darin
gespeicherten Daten geladen und dargestellt.

Wählen Sie als Darstellungsform “Diagramm”.

Über das Menü “Format” > “Muster” können Sie Farbe und
Muster des Hintergrunds und der Gitternetzlinien
anpassen.

Klick auf eine Messkurve zeigt die Eigenschaften des
ausgewählten Kanals an, die Sie ebenfalls einstellen
können.

Um die Daten zu speichern, wählen Sie im Menü “Datei”
“Speichern unter ...”.

Die gespeicherten Daten können Sie über “Datei” >
“Öffnen” jederzeit wieder anzeigen.
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testo 175/177:Teilbereich auslesen und
exportieren

Beispiel 3

Zur Einrichtung einer Verbindung zwischen Datenlogger
und Software, sowie zur Programmierung des
Datenloggers lesen Sie bitte die Bedienungsanleitung zum
Datenlogger.

Legen sie einen Datenlogger der Werte gespeichert hat in
die Tischschale, die mit dem Interface verbunden ist.

Durch Doppelklick auf das Gerät im Datenbereich wird die
Verbindung hergestellt. Unter dem Gerät erscheint das im
Gerät gespeicherte Protokoll.

Durch Klick rechts auf das Protokollsymbol erscheint ein
Kontext-Menü. Wählen Sie “Teilbereiche auslesen ...”.

Das Fenster “Teilbereiche auslesen” öffnet. Wählen Sie den
Wertebereich aus, den Sie darstellen möchten:
“Datum/Zeit”, “Zeilen” oder “Seit Zeitmarke”. Die Zeitmarke
ist eine Zwischenmarke, die im Datenlogger gesetzt
werden kann (siehe Bedienungsanleitung zum
Datenlogger).

Die ausgewählten Werte werden dargestellt.

Wählen Sie in der Symbolleiste “Kopieren”.

Öffnen Sie Microsoft Excel und wählen Sie “Bearbeiten” >
“Einfügen”.

Die Messwerte werden in die Excel-Tabelle übernommen.
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• Prüfen Sie, ob das Gerät eingeschaltet ist.
• Prüfen Sie das Verbindungskabel.

Diese Meldung erscheint, wenn das PC-Programm das
angeschlossene Messgerät nicht ansprechen kann, bzw.
wenn das Messgerät nach Aufruf nicht antwortet.

- Ist das Gerät eingeschaltet?
- Wird das Gerät ausreichend mit Strom versorgt?
- Ist das Verbindungskabel angeschlossen?
- Ist es das richtige Verbindungskabel?
- Am richtigen COM-Port angeschlossen?

- Sie versuchen eine Online Messung von einem Gerät zu
erhalten, an das keine Fühler angeschlossen sind.

- Schließen Sie die entsprechenden Fühler an.
- Es sind nicht alle Eingangsgrößen für die Funktion “...”

im Messprotokoll enthalten. Sie haben eine vordefinierte
Funktion ausgewählt, die zur Berechnung mehr oder
andere Messgrößen benötigt als die, die im Messprotokoll
enthalten sind. z.B. Sie wollen den Taupunkt berechnen,
stellen aber nur die Temperatur zur Verfügung, die Größe
Feuchte fehlt.

Es wird vom Programm nicht zugelassen, dass gefüllte
Ordner pauschal gelöscht werden. Löschen Sie die darin
enthaltenen Daten bzw. Messorte um danach den leeren
Ordner löschen zu können oder löschen Sie den Ordner im
Windows Explorer.

- Sie wollen eine Datei löschen, die sich noch geöffnet zur
Bearbeitung im Arbeitsbereich befindet. Offene Dateien
können nicht gelöscht werden,

- Schließen Sie die Datei.

Fehlermeldungen

Gerät antwortet nicht ...:

Ihr Gerät hat keine
funktionstüchtigen
Fühler gemeldet
Messung nicht möglich.

Der Ordner ist nicht leer.
Löschen nicht möglich:

Löschen des Protokolls
nicht möglich:

Schließen und löschen
Sie die Datei.
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Fehlermeldungen

Benennen Sie den Namen um und verzichten Sie auf diese
Sonderzeichen.

Für die Einrichtung von Geräten ist eine eindeutige
Namensgebung notwendig, dabei dürfen verschiedene
Geräte nicht unter demselben Namen angemeldet werden.

- Sie versuchen mit ungültigen Daten Protokolle zu
verbinden. Speziell überlappende Zeitbereiche sind nicht
in einem gemeinsamen Protokoll zusammenführbar.

Ungültiger Name:

Die Zeichen: !,?,*,:,\
können in Messort- und
Ordnernamen nicht
verwandt werden.

Eine Geräteeinstellung
mit diesem Namen ist
schon vorhanden:

Bitte wählen Sie einen 
neuen Namen.

Die Zeitbereiche
überlappen
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Die Testo Comfort-Software beinhaltet alle Funktionen, um
Testo-Messgeräte anzusteuern und zu konfigurieren,
Messdaten in Ihren PC zu übertragen und dort zu
bearbeiten. Dieses Kapitel beschreibt alle dazu
notwendigen Befehle.

Die Testo Comfort-Software ist in zwei wesentliche
Bereiche unterteilt: den Datenbereich und den
Arbeitsbereich.

Der Datenbereich
In diesem Bereich werden Ihre Messgeräte verwaltet.

Nach dem Programmstart sind alle Messgeräte inaktiv.
Wollen Sie ein angeschlossenes Messgerät aktivieren,
doppelklicken Sie auf das Symbol des entsprechenden
Messgerätes. Die Verbindung zum Messgerät wird
hergestellt.

Hinweis: Das Messgerät muss am richtigen Port
angeschlossen sein, damit eine Verbindung hergestellt
werden kann.

Ist im Messgerät ein Messprotokoll gespeichert, so wird
dieses unter dem Gerätesymbol dargestellt.
Das Messprotokoll wird durch ein Symbol und einen
Kurztitel gekennzeichnet.

Details/Hintergründe
Darstellungsbereiche

Messprotokoll
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Der Arbeitsbereich
In diesem Bereich werden Ihre Daten angezeigt.
Sie können auswählen, in welcher Art die Anzeige erfolgt:
Tabelle oder Diagramm.

Ein nachträgliches Ändern der Ansicht ist jederzeit möglich.
Klicken Sie hierfür einfach auf das entsprechende Symbol
in der Symbolleiste.

Details/Hintergründe
Darstellungsbereiche
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Menü Datei

Öffnen
Die Daten eines Messprotokolls können eingelesen
werden. Sie können diese beispielsweise als
Referenzdaten hinterlegen und eine aktuelle Messung
darüber legen.
Messdatendateien haben die Dateinamenserweiterung
„prn“ oder „vi2“. Akzeptiert werden nur solche Dateien, die
mit dieser, einer Vorgängerversion, oder der Testo PC-
Adapter Software erfaßt wurden! Erstellte „wks“-Dateien
können ebenfalls eingelesen werden.

Datei speichern
Damit wird ein Messprotokolldatensatz unter dem in der
obersten Zeile angezeigten Namen und Dateityp
gespeichert. Handelt es sich um einen neu erstellten
Datensatz, der noch keinen Namen erhalten hat, ist die
Auswahl des Namens nötig.

Datei speichern unter
Damit wird ein Messprotokolldatensatz in einer Datei auf
der Festplatte Ihres Computers abgespeichert. Während
der Messung werden Daten im Arbeitsspeicher Ihres
Computers gespeichert. Dessen Inhalt wird bei Beenden
des Programms gelöscht. Um Protokolle bleibenden Werts
zu erzeugen oder die Messdaten später mit diesem oder
anderen Programmen auszuwerten, zu drucken, usw..., ist
es notwendig, sie in einer Datei abzuspeichern.

Details/Hintergründe
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Seitenansicht
Die aktuelle Ansicht wird so auf dem Bildschirm angezeigt,
wie sie auf dem Drucker ausgegeben wird.

Drucken
Messdaten können in Diagramm- oder Tabellenform auf
den Drucker ausgegeben werden. Gedruckt wird ein
Formblatt bestehend aus:

1. Protokollkopf mit Titel (mit Datei- oder Gerätenamen),
Datum, Start- und Endezeit einer Messung (nur
Tabellen), Kanal- und Messwertanzahl (nur Tabellen),
laufender Seitennummer, einer Zeile „Bedingungen“ und
zusätzlichen Kommentarzeilen.

2. Messdaten in Diagramm- oder Tabellenform.
Beim Ausdrucken enthält der Protokollkopf Informationen
über das gesamte Messprotokoll.

Beim Tabellendruck verwenden Sie am besten
Hochformat, zum Diagrammausdruck empfiehlt sich
Querformat.
Das Format stellen Sie mit  “ Seite einrichten “ ein.

Ausdruck Diagramm (Beispiel)

Menü Datei

Details/Hintergründe
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Menü Gerät

Neues Gerät 
Der Assistent zur Geräteeinrichtung unterstützt Sie beim
Hinzufügen von weiteren Messgeräten zu Ihrer
Konfiguration.
Mit dem „Weiter“-Knopf kommen Sie zur nächsten Seite,
mit dem „zurück“-Knopf zur jeweils vorhergehenden.

Das neu einzurichtende Gerät sollte mit dem Rechner
verbunden und eingeschalten sein, da der
Einrichtungsassistent nach Abschluss des Einrichtens den
Verbindungsaufbau zum Messgerät überprüft.

1. Es erscheint eine Seite zur Gerätewahl. Wählen Sie hier
den von Ihnen neu angeschlossenen Gerätetyp aus.

2. Als nächstes müssen Sie die Schnittstelle wählen, an
der das Gerät angeschlossen ist. Erst wenn Sie eine
Schnittstelle gewählt haben, können Sie diese Seite
verlassen.

3. Jetzt können Sie dem neu eingerichteten Gerät einen
Namen vergeben, unter dem es in der Comfort-Software
auftauchen soll. Hierbei ist zu beachten, dass Sie einen
Namen wählen, der nicht bereits von einem anderen
Gerät benutzt wird. Standardmäßig wird hier die
Messgerätebezeichnung angezeigt.

4. Es wird versucht, eine Verbindung zum Gerät
aufzubauen.

Details/Hintergründe
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Autodetect
Autodetect sucht automatisch nach angeschlossenen
Geräten und stellt die Verbindung automatisch her.

Gerätesteuerung
Dieser Menüpunkt dient dazu, die zum ausgewählten Gerät
zugehörige Konfigurationsseite aufzurufen. Diese sind auf
die entsprechenden Geräte abgestimmt und stellen die
jeweils verfügbaren Einstellmöglichkeiten zur Verfügung.

Menü Gerät

Details/Hintergründe

Gerätesteuerung testo 175/177

Gerätesteuerung testo 174
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Online-Messungen sind mit dem testo 174 nicht möglich!

Online 
Wenn Sie ein Gerät geöffnet haben, erscheint unter diesem
Menüpunkt einer von zwei möglichen Einträgen:

Start 
Mit diesem Menüpunkt/Icon starten Sie die Online-
Messung. Die Messdaten werden automatisch im
Arbeitsbereich angezeigt.

Stop 
Mit diesem Menüpunkt/Icon halten Sie die laufende Online-
Messung an. Sie können das entstandene Protokoll im
Arbeitsbereich jetzt auch auf der Festplatte speichern.

ONLINE Konfiguration 
Hier kann die Messrate für die Online-Messung eingestellt
werden. Die minimal einstellbare Messrate hängt vom
Gerät ab und wird entsprechend überprüft.

In regelmäßigen Abständen werden die Daten in einer
temporären Datei auf der Festplatte zwischengepuffert.

Details/Hintergründe
Menü Gerät
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Details/Hintergründe
Menü Bearbeiten

Kopieren
Diagramme, Tabellen oder Ausschnitte daraus können in
die WINDOWS Zwischenablage kopiert werden und stehen
so in anderen Anwendungsprogrammen unter dem
Menüpunkt EINFÜGEN zur Verfügung. So können Sie ein
Bild oder die Werte einer Tabelle in ein anderes Programm
übernehmen. Ebenso können Sie Daten innerhalb der
Comfort-Software auf diese Weise kopieren.

Hinweis:
Um ein Bild eines Graphen für den späteren Ausdruck
durch ein anderes Programm vorzubereiten, wählen Sie
vorher eine für das Ausgabegerät geeignete
Zusammenstellung von Linien- und Hintergrundfarbe bzw.
Punktmustern.

Einfügen
Messreihen, die in die Zwischenablage kopiert wurden,
können hiermit an die gewünschte Stelle eingefügt werden.
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Details/Hintergründe
Menü Ansicht

Hier liegen alle Funktionen, die den Bildschirmaufbau
betreffen. Im Einzelnen sind in diesem Menü folgende
Funktionen enthalten:

Symbolzeile
Ein-/ausblenden der Symbolleiste. Damit haben Sie bei
Bedarf mehr Platz auf dem Bildschirm um Daten
darzustellen.

Statuszeile
Die unterste Fensterzeile wird ein- oder ausgeblendet. Hier
werden normalerweise Informationen, Zustände und
Hinweise dargestellt.

Gerät(e)
Der Datenbereich mit der Anzeige der Geräte wird ein-
oder ausgeblendet. So steht bei Bedarf mehr Platz für die
Darstellung von Tabellen und Diagrammen zur Verfügung.
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Details/Hintergründe
Menü Format

Dieser Menüpunkt beinhaltet folgende Einträge:

Zeichen
Hier können Sie Einstellungen zum verwendeten
Zeichensatz vornehmen. Dieser Zeichensatz wird dann für
Protokolle und zum Beschriften von Diagrammen
verwendet.

Muster
Hier haben Sie die Möglichkeit, Einheiten, gemeinsame
Achsen, Hintergrundfarbe und Grenzwertfarben
einzurichten.
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Details/Hintergründe
Menü Fenster

Fenster
Hier stehen folgende Menüpunkte zur Auswahl:

Nebeneinander 
Untereinander 
Überlappend
Alle schliessen

Sie können die geöffneten Fenster entsprechend anordnen.

Die Namen aller geöffneten Messprotokolle werden
angezeigt. Das jeweils aktive (im Vordergrund liegende)
Fenster wird durch einen Haken markiert.
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This is a legally binding contract between you, as the end user, and Testo.
Once you or another authorised person opens the sealed CD-ROM packaging, the conditions of this
contract are recognised. If you do not agree with the conditions, return the unopened software package
with all accompanying items, including all written documentation and boxes, to the point from which you
purchased the software and your money will be returned in full.

Concession
This licence authorises you to use a copy of the Testo software, acquired with this licence, on a single
computer on condition that the software is only used on one computer at any one time. If you have acquired
multiple licences for the software you can have so many copies in use as you have licences. The software
is deemed as being “in use” on a computer if it is loaded in a cache i.e. RAM or if it is saved in a permanent
memory e.g. on the hard disk of this computer, with the exception of a copy installed in a network server for
the sole purpose of distribution to other computers which is then deemed as not being “in use”. If the
number of persons using the software exceeds the number of licences acquired you are then required to
provide suitable mechanisms or procedures to ensure that the number of persons using the software
simultaneously does not exceed the number of licences.

Copyright
The software is protected against copying by copyright laws, international contracts and other legal
stipulations. It is forbidden to copy the software, product manuals and other accompanying written
documents on the software. The software should not be licenced, rented or leased. If the software is not
provided with technical protection you can make a single copy of the software solely for security and filing
purposes or you can transmit the software to one hard disk on condition that the original is kept solely for
security or filing purposes. Reverse engineering, decompilation, disassembly are not permitted. For every
infringement of protective rights you or any authorised person are liable to claims from Testo AG
Lenzkirch.

Limited warranty
Testo guarantees for a period of 90 days following the acquisition of the software  by the buyer or for a
longer minimum time period if stipulated by the laws in the country of purchase that the software generally
corresponds to the standards defined in the accompanying documentation. Testo specifically does not
guarantee that the software will run without interruptions or errors. If the software does not function
normally in accordance with the accompanying documentation, the purchaser then has the right to return
the software to Testo within the warranty time accompanied by a written description on the malfunction(s).
Testo is only obliged, after a reasonable time period, to make a functioning copy of the software available to
the purchaser or to refund the full purchase price if a copy is unavailable for whatever reason.

Any guarantees in relation to the software, the corresponding manuals and written documentation
exceeding the above limited warranty are not admitted.

Neither Testo nor Testo suppliers are obliged to replace any damage occurring during use of this Testo
product or caused by the inability to use this Testo product even if Testo has been informed of the possibility
of such damage. This exclusion does not apply to damage caused deliberately or through gross negligence
by Testo. Likewise claims supported by inalienable legal stipulations are unaffected.

Copyright © by 2001 Testo AG

M. Windows® und Excel® are the registered trade marks of the Microsoft Corporation.

Licence Agreement
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The Comsoft 3 software is used to save, read and analyse
separate measurement values and measurement series.
The main task of this program is the graphic display of
readings.
Readings are taken using Testo´s measuring instruments
and are transmitted via serial interface to your PC.
Data is read using Comsoft 3 software, which activates the
interfaces and makes all functions available.

There are suitable instrument drivers available for installing
each Testo instrument/system which are especially adapted
to the instrument hardware and their operation.

Measured readings are logged with date and time. Values
are constantly updated during ONLINE measurements.

Intended use

Preparation
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Minimum system requirements
• PC with operating system

- Microsoft Windows 95 or better (if compatible)
- Microsoft Windows NT 4, Service pack 4, or better 

(if compatible).
- Windows 2000 or newer (if compatible).

• CD-Rom drive
• Pentium 100 MHz
• 32 MB RAM
• 15 MB hard disk drive space free
• Free serial interface (COM) or corresponding adapter.

Installation
1. Place CD-ROM in drive

2. The installation menu will start up after a short time. If it
fails to start, click twice on “Setup.EXE” on the CD-ROM.

3.You are asked to enter the licence number (see sticker
on CD-ROM).
Rebooting may be necessary if it is the first installation.
Note: If the number input is not accepted it may be due
to the following:
- Is the shift button activated?
- Is “Num” in the separate digit pad activated?
- Was l entered instead of 1?
- Was o entered instead of 0?

4. Once confirmed, the rest of the installation is menu-
driven. Please observe the notes and explanations
beside the buttons.

Installation

Preparation
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General information on using and installing software
The software surface (appearance, operation philosophy )
is defined in accordance with the Microsoft® Office
Standard. Icons and menu items are selected analog to this
standard. Therefore, if you are already working with Office
programs (Word®, Excel®, PowerPoint® ...), you will very
quickly become familiar with the surface.

Preparation
Installation
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1st session – Brief instructions

Certain menu functions can be activated directly via the
mouse, making the software easy to use.
Some menu functions need only to be clicked on once with
the mouse while others need to be clicked twice.

The following options are available depending on where
you are in the program:

Click left on
menu item: Opens sub-menu or  

carries out function

Click left on 
icon button: Carries out function

Click left on 
name in archive: Selects

Click twice, left: Selects and opens/carries out

Click right: Opens context menu 
(if available)

Mouse functions 



42

Toolbar

1st session - Brief instructions

You can acitvate commands, which are used often, directly
using the icons in the toolbars.

Instrument category

Open file

Save activated document

Print view

Page view 

Copy in clipboard

Insert contents in clipboard

Use help

Use situation-related help function
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Toolbar

1st session - Brief instructions

Instrument category

Device control

Start online measurement

Stop online measurement

View category

View as diagram

View as table

Left mouse button enlarges

Left mouse button shows crosshair

Select font
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Menu bar

1st session – Brief instructions

Going from left to right the menu bar includes the following:

File
All of the functions, which are needed to open, close, save,
delete and print. The program can be exited in this menu.

Instrument
Connection to the measuring instruments is controlled from
this menu. New measuring instruments can be connected
and configured.

Bearbeiten
The functions for copying and inserting files are located
here.
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View
Included are functions required for graphical display or
screen layout. Toolbars, status bars and archives can be
made to appear or disappear, as required.

Format
The font can be set here. This font is then used for logs and
to label diagrams.
The appearance of the diagrams and tables can be
improved optically using specific patterns/styles.

Window
If you have several files at the same time in the RAM
memory, you have several ways available to display them.

?
You can call up help in this menu and service data is
shown.

Menu bar

1st session – Brief instructions
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This is a range of commands, selected especially for a
certain area. Commands relevant to the context are made
available, depending on the position of the mouse, by
clicking with the right mouse button.

Context menus

1st session – Brief instructions
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Online help

Online help is available for many functions. This online help
is activated by pressing F1 (function button on the keypad)
or by clicking on “?” in the menu bar.

Press Shift+F1 for direct help. The cursor arrow will then
turn into a question mark with an arrow.You should click on
the area about which you have a question. The online help
for this topic will then be opened.

1st session – Brief instructions
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Demo file without instrument

Measured data has to be opened first before it can be
shown graphically.

The data is located in the memory of Testo instruments or
in a directory on a PC data carrier for data, which has
already been filed (in this case: demo files).

Once the “File” menu item has been selected, the “Open”
menu element is selected.

The “File/Open” dialog mask then appears.

A drive or a folder can be selected in the top part of the
dialog mask. A list with file names appears in the middle
part. The type of files required is selected in “Files of type”.

The following are available:
- *.vi2 Standard files, created by 

ComSoft 3
- *.prn Files from the software versions  

2.51 and older, saved
as an ASCII text file

- *.WKS Files from the software versions 
2.51 and older, saved as WKS

- *.* All files.

Example 1
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Note: View files from earlier software versions (*.viw) are no
longer available.

The demo files are located in the following directory:
“...\Archive\Example files”

A file name is picked out and is opened by clicking on it
twice or clicking on the “Open” button.
You can determine what form the measurement log is to
appear in by clicking on the “Table” or “Diagram” icons.

Diagram

Table

Demo file without instrument

Example 1
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Demo file without instrument

Example 1

Load a file from the “Sample files” folder and test the
functions available:

Zoom
Zooms sections

The limits for the area to be shown are set by drawing a
rectangle in the diagram window (keep left mouse button
pressed inside window).
This function is also available during an online
measurement. The selected section always shows the
current value.

The diagram is returned to its normal size by clicking on
“Original size”. All of the section zooms are then undone.

“Crosshair”
Select a measurement curve to demonstrate a crosshair,
which follows the curve. The reading number, date, time
and reading are also shown in a window.

“Edit pattern”
This function is located in the “Format” menu.
It is used in diagrams to set background and grid line colour
and to change the line type in the grid.
It is used in tables to highlight limit values.
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Demo file without instrument

Example 1

Start by clicking on the respective curve twice and first
adapt the line width and pattern, smooth the curve and
mark the measurement points, if required.

Define the required limit values in “Data series” and define
how they are to be displayed in “Limit value display”.

You will find modification possibilities for background and
grid lines in “Pattern” in the format menu.
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Example 1

Edit the time axis:
You can define the resolution, start and finish of the view
window by clicking twice or clicking right on the time axis.

- “Relative timing” sets the starting time at 00:00,
the time then starts relative to this start mark.

- “Width” defines a fixed frame which can be
moved over the time axis.

- “Position” defines a fixed section.
- “Division” determines how often the grid lines

are to be repeated.

Optimise the value range/y axis
For an improved overview, it is better to scale the range of
values for the respective curve. Enter the menu by clicking
twice or by clicking on the right of the y axis. The grid can
be set via the arrow buttons or can be entered manually.

Demo file without instrument



53

Example 1

Demo file wihout instrument

Printing measurement data
Measurement data can be printed in diagram or table form.
A standard sheet is printed as follows:

• Protocol header with
- Title (file or instrument names), 
- Date,
- Start and finishing time of a measurement (tables only),
- Channel and reading number (tables only),
- Consecutive page number,
- Option of entering “Conditions”,
- Other additional comment lines.

The printed protocol header contains information on the
complete measurement log.

It is recommended to use portrait format when printing
tables, and landscape format when printing diagrams.
Select the format required in the “Page Setup” menu.
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testo 174: Reading out data, editing
diagrams and saving data

Example 2

Consult the Data logger Instruction manual to find out how
to set up a connection between data logger and software
and how to program the data logger.

Place a data logger, which has values saved, in the
interface.

The connection is set up by clicking twice on instrument in
archive. The log saved in the instrument appears under
instrument.

The data saved in the log can be opened and shown by
clicking twice on the log.

Select “Diagram”.

You can adapt the background and grid line colour and
pattern via the “Format” > “Pattern” menu.

A click on the measurement curve will show the properties
of the selected channel, which you can also set.

Select “File” “Save As ...” to save the data.

The saved data can be shown at any time via “File” >
“Open”.
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testo 175/177: Reading out and exporting
sections

Example 3

Consult the Data logger Instruction manual to find out how
to set up a connection between data logger and software
and how to program the data logger.

Place a logger, which has values saved, in the desk-top
holder which is connected to an interface.

The connection is set up by clicking twice on instrument in
the archive. The log saved in the instrument appears under
instrument.

A context menu will appear by clicking right on the log icon.
Select “Reading out sections ...”.

The “Reading out sections” window opens. Select the value
range which you want to show: “Date/Time”, “Lines” or
“From time mark”. The time mark is an intermediate mark
which can be set in the data logger (refer to the Data logger
Instruction manual).

The selected values are shown.

Select “Copy” in the toolbar.

Open Microsoft Excel and select “Edit” > “Paste”.

The readings are accepted into the Excel table.
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• Check if instrument is switched on.
• Check connection cable.

This message appears if the PC program cannot
communicate with the connected measuring instrument or
if the measuring instrument does not respond.

- Is the instrument switched on?
- Has the instrument sufficient power?
- Is the connection cable connected?
- Is it the correct connection cable?
- Correct COM Port connection?

- You are trying to get an online measurement from an
instrument to which a probe is not connected.

- Connect the corresponding probes.
- Not all of the input variables for the function “...”

are contained in the measurement log.You have selected
a pre-defined function, which needs more or other
parameters than those included in the measurement log
e.g. you want to calculate the dew point, but only the
temperature is available, the humidity parameter is
missing.

The program does not allow you to simply delete full
folders. First delete the data or locations in the folder in
order to be able to delete the empty folders or delete the
folder in Windows Explorer.

- You want to delete a file, which is still open for editing.
Open files cannot be deleted.

- Close the file.

Error messages

Instrument is not
responding ...:

Your instrument has
indicated that probes are
not working
Measuring impossible.

The folder is not empty.
Not possible to delete:

Not possible to delete
log:

Close and delete the file.
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Error messages

Rename the location/folder and do not use these
characters.

Different names should be used when setting up new
instruments. The same names should not be used for
different instruments.

- You are trying to connect logs using invalid data.
Overlapping time ranges cannot always be put together in
a common log.

Invalid name:

: !,?,*,:,\ cannot be used
in location and folder
names.

An instrument setting
with this name is already
available:

Please select a new
name.

The time ranges overlap
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Testo Comfort software has all the functions needed to
control and configure Testo measuring instruments, to
transmit data to your PC and to edit it. This Chapter
describes all the commands necessary.

Testo Comfort-Software is divided into two main parts: the
archive and the work area.

Archive
Your measuring instruments and measurement data are
managed in this area.

All of the measuring instruments are inactivated when the
program starts. If you want to activate a measuring
instrument, which is connected, click twice on the icon for
the measuring instrument. The connection to the measuring
instrument is set up.

Note: The measuring instrument has to be connected to the
correct port in order for a connection to be set up.

If a log is saved in the measuring instrument, it is shown
under the instrument icon.
The log is represented by an icon and a title.

Details/Background
Display ranges

Log
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Work area
Your data is shown in this area.
You can decide on the type of display: table or diagram.

It is possible to change the view at any time, if so required.
Simply click on the corresponding icon in the toolbar.

Details/Background
Display ranges
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File menu

Open
The data of a log can be read in. For example, you can
make it your reference data and place a current
measurement over it.
Measurement data files have the file name extension “prn”
or “vi2”. Only files which were set up using this version, a
previous version, or the Testo PC adapter software are
accepted! “wks” files can also be read in.

Saving files
Measurement log data is saved as the name and type
displayed in the top line, using this function. If it is newly
created data, which does not yet possess a name, it is
necessary to select one.

Saving files as
Measurement log data is saved in a file on the hard disk of
your computer. Data is saved in the RAM memory of your
computer during measuring. This is deleted once you exit
the program. If you wish to create logs with stable values or
you wish to analyse, print the data etc. with this or other
programs at a later stage, you should save the data in a
file.

Details/Background
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Print Preview
The view will be printed exactly as it appears on the screen.

Printing
Measured data can be printed in diagram or table form. A
sheet is printed containing the following elements:

1. Protocol header with title (pre-set with file or instrument
names), date, start or finishing time of a measurement
(tables only), channel and reading number (tables only),
current page number, “Conditions” line and additional
comment lines.

2. Measured data in diagram or table form.
When printed, the protocol header contains information
on the complete measurement log.

It is recommended to use portrait format when printing
tables and landscape format when printing diagrams.
Set the format in “Page Setup”.

Example of printout of diagram

File menu

Details/Background
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Instrument menu

New device  
The assistent for setting up the instrument supports you
when adding additional measuring instruments to your
configuration.
You will get to the next page via “Next” and to the previous
page via “Back”.

The instrument, which is to be set up, should be connected
to the computer and switched on, since the New device
setup wizard checks the connection to the measuring
instrument once setup is complete.

1. A list of instruments appears for you to select. Select the
instrument which you have just connected.

2. The next step is to select the interface to which the
instrument is connected. It is only when you have
selected an interface that you can leave this page.

3.You can now assign your newly setup instrument a
name, under which it should appear in the Comfort
software. Make sure that you choose a name which is
not already being used for another instrument. Usually
the name of the measuring instrument is shown.

4. An attempt is made to set up a connection to the
instrument.

Details/Background
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Autodetect
Autodetect automatically searches for connected
instruments and automatically sets up the connection.

Device control
This menu item is used to call up the configuration page of
the selected instrument. They are adapted to the
corresponding instruments and make available the
respective setting options on offer.

Instrument menu

Details/Background

Device control/ testo 175/177

Device control/ testo 174
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Online measurements are not possible with testo 174!

Online 
One of two possible elements appears in this menu item,
once you have opened an instrument:

Start 
Start the online measurement with this menu item/icon.
Data is shown automatically in the work area.

Stop 
You can stop the current online measurement with this
menu item/icon.You can now also save the log from the
work area on your hard disk.

ONLINE Configuration 
The measuring rate for online measurement is set here.
The minimum adjustable measuring rate depends on the
instrument and is checked accordingly.

The data is buffered, at regular intervals, in a temporary file
on the hard disk.

Details/Background
Instrument menu
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Details/Background
Edit menu

Copy
Diagrams, tables or sections of the tables can be copied
into the WINDOWS clipboard which are then available in
other application programs in the PASTE menu item. In this
way, you can copy a graph or values from another table into
another program.You can also copy the data within Comfort
software in the same way.

Note:
To prepare the picture of a graph for subsequent printing
using a different program, please first select the line and
background colour or patterns/styles which can be printed.

Paste
Measurement series, copied to the clipboard, can be
pasted to the required point.
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Details/Backgrounds
View menu

All of the functions pertaining to screen layout and graphic
design are located here. The following is a list of the
functions included in this menu:

Toolbar
Switches functions, which appear in “Tools, Customize”, on
or off, as required. In this way, you have more space on
your screen to show data.

Status bar
The bottom window line is switched on or off. Information,
statuses and notes are normally shown here.

Instrument(s)
The archive with display of instruments is activated or
deactivated. More space is then made available to show
tables and diagrams, if required.
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Details/Background
Format menu

This menu item contains the following entries:

Font
You can set the fonts to be used here. This font is then used
for logs and to label diagrams.

Pattern
Used to set units, common axes, background colour and
limit value colours.
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Details/Background
Window menu

Window
The following menu items can be selected:

Tiled 
Tiled horizontally 
Cascading
Close all

The names of all the open measurement logs are shown.
The window which is activated (in foreground) is marked
with a tick.



69

Testo weltweit

Testo worldwide

ARGENTINA
Automat Medicion S.R.L.
1427 Buenos Aires
Tel. (11) 45 55 00 55
Fax (11) 45 55 04 44
automat@infivia.com.ar

AUSTRALIA
Testo Pty. Ltd.
Bayswater, Victoria 3153
Tel. (3) 97 20 00 11
Fax (3) 97 20 00 22
info@testo.com.au

AUSTRIA
Testo Ges. mbH
1170 Wien
Tel. (1) 4 86 26 11- 0 
Fax (1) 4 86 26 11 20
info@testo.at

BELGIUM/LUXEMBURG
S. A. Testo N. V.
1741 Ternat 
Tel. (2) 5 82 03 61 
Fax (2) 5 82 62 13
info@testo.be

BOLIVIA
T.E.C.
Av. Peru Nro. 1033
Cochabamba
Tel. (4) 4 28 60 02 
Fax (4) 28 60 02
tec@supernet.com.bo

BOSNIA-HERZIGOWINA
Tehnounion Sarajevo
Sarajevo
Tel. (33) 20 59 44 
Fax (33) 44 40 00

BRAZIL
Testo do Brazil
13024-240 Campinas - SP
Tel. (19) 32 55 74 61 
Fax (19) 32 95 69 00 
testo@testo.com.br

BULGARIA
Global Test OOD
1000 Sofia
Tel. (2) 9 53 07 96, 
Fax (2) 9 53 07 96
glbl_tst@sps.bg

CHILE
ANWO Chile S.A.
Santiago
Tel. (2) 7 31 00 00 
Fax (2) 2 73 04 04
instrumentos@anwo.cl

CHINA
Testo Far East Ltd.
Shanghai 200031 
Tel. (21) 5456-6470
Fax (21) 5456-1470
testo@guomai.sh.cn

CIS
Global Export GmbH 
105 023 Moscow
Tel. (0 95) 3 60 53 68 
Fax (0 95) 3 60 53 68
global_export@aport2000.ru

COLOMBIA
Arotec Colombiana S. A.
Bogota D. E.
Tel. (1) 2 88 77 99 
Fax (1) 2 85 36 04
mantenimiento@arotec.net

COSTA RICA
Representaciones Corelsa S. A.
San José
Tel. 2 44 25 50 
Fax 2 44 30 90
corelsa@sol.racsa.co.cr.

CROATIA
"H.I.P." Zagreb d.o.o.
10090 Zagreb
Tel. (1) 3 73 40 07 
Fax (1) 3 73 40 44
hip@inet.hr

CYPRUS
Deksa Ltd.
Tel. (2) 31 31 41 
Fax (2) 49 70 59
deksa@cytanet.com.cy

CZECH REPUBLIC 
Testo s.r.o.
158 00 Praha 5
Tel. (2) 57 29 02 05 
Fax (2) 57 29 04 10
info@testo.cz

DENMARK
Buhl & Bonsoe A/S
2830 Virum
Tel. 45 95 04 10 
Fax 45 95 04 12
inf@buhl-bonsoe.dk

EASTERN EUROPE
Testo Osteuropa GmbH 
79850 Lenzkirch
Tel. (0 76 53) 6 81 - 141
Fax. (0 76 53) 6 81 - 102
pmies@testo.de

EGYPT
Future Plants Contractors
Heliopolis 11 361, Cairo
Tel. (2) 4 18 67 79 
Fax (2) 4 18 95 04
future98@intouch.com.

EL SALVADOR
Eco Control S.A de C.V.
San Salvador
Tel. 2 60 66 01 
Fax 2 60 66 02
eco.control@saltel.net

FINLAND
Humitec Oy
00410 Helsinki
Tel. (9) 5 30 84 00
Fax (9) 53 08 40 99
testo@humitec.fi

FRANCE
testo S.à.r.l.
57602 Forbach
Tel. 3 87 29 29 00 
Fax 3 87 87 40 79
info@testo.fr

GREECE
Sigma Hellas Ltd.
185 36 Piraeus
Tel. (10) 4 18 01 67
Fax (10) 4 51 90 20
sigmahellas@hol.gr

GREAT BRITAIN
Testo Ltd.
Alton, Hampshire  GU34  2QE
Tel. (14 20) 54 44 33 
Fax (14 20) 54 44 34
info@testo.co.uk
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HONG KONG
Testo Far East Ltd.
Shatin, N. T., Hong Kong, PRC
Tel. 26 45 16 11 
Fax 26 45 16 10
testo@testofe.com.hk

HUNGARY
Testo Kft.
1139 Budapest
Tel. 237 17 47 
Fax 237 17 48
testo@testo.hu

ICELAND
Rafn Jensson, Mechanical 
Engineers ehf
110 Reykjavik
Tel. 5 67 80 30 
Fax 5 67 80 15
rj@rj.is

INDIA
Siskin Instruments Co. (P) Ltd. "JULABO"
Bangalore 560 054
Tel. (80) 3 60 25 60 
Fax (80) 3 60 36 79
siskin@eth.net

IRAN
Mehr Kanaz Co.
Tehran
Tel. (21) 2 26 26 89 
Fax (21) 2 22 37 77
info@mehr-kanaz.com

ISRAEL
Manoraz Ltd.
Azur 58001
Tel. (3) 5 59 33 99 
Fax (3) 5 58 44 95
david@manoraz.com

ITALY
Testo S.p.A.
20019 Settimo Milanese (Mi)
Tel. (02) 33 50 33 05 (r.a.) 
Fax (02) 33 50 33 06
info@testo.it

JAPAN
Testoterm K.K.
Yokohama 226
Tel. (45) 4 76 22 88 
Fax (45) 4 76 22 77
info@testo.co.jp

JORDAN
Al-Masar Technique Est.
Sahab 115-12
Tel. (6) 4 02 95 22 
Fax (6) 4 02 35 64
masar@nets.com.jo

KOREA (Republic of)
Testo (Korea) Ltd.
Seoul 150-102
Tel. (2)  6 72 72 00 
Fax (2)  6 79 98 53
testo@testo.co.kr

MACEDONIA
Pharmachem Skopje
1060 Skopje
Tel. (2) 33 11 93 
Fax (2) 33 14 34
farmahem@mt.net.mk

MEXICO
Grupo de Instrumentación y Medición
Industrial de México, S.A. de C.V.
08920 Mexico, D.F.
Tel. (55) 56 34 04 02 
Fax (55) 56 33 04 01
scc@gimin.com

NETHERLANDS
Testo B.V.
1314 BH Almere-Stad
Tel. (36) 5 48 70 00 
Fax (36) 5 48 70 09
info@testo.nl

NEW ZEALAND
Eurotec Instruments Ltd.
Auckland  
Tel. (9) 5 79 19 90
Fax (9) 5 25 33 34
cfarmer@eurotec.co.nz

NICARAGUA
Adolfo Gröber & Cía Ltda.
Managua
Tel. 2 66 51 36 
Fax 2 66 51 39
a.grober@cablenet.com.ni

Norway
Max Sievert A/S
0134 Oslo
Tel. (22) 17 30 85 
Fax (22) 17 25 11
firmapost@maxsievert.no

PERU
JJL Asociados S.A.
Lima 17
Tel. (1) 2 61 17 52
Fax (1) 4 61 46 07
jlasociados@hotmail.com

PHILIPPINES
Keystone Industrial
Trading Corporation
Pasay City 1300, 
Tel. (2) 8 31 95 71 
Fax (2) 8 31 40 13
keystone@globenet.com.ph

POLAND
Testo Sp.z.o.o.
02-362 Warszawa
Tel. (22) 8 63 74 22
Fax (22) 8 63 74 15
testo@testo.com.pl

PORTUGAL
Testo LDA.
3800-559 Paco do Cacia 
Tel. 96 76 00 45 34
Fax 234 08 37 08
testo@netvisao.pt

REPUBLIC OF SOUTH AFRICA
Unitemp
Landsdowne, Cape Town, 7779
Tel. (21) 7 62 89 95 
Fax (21) 7 62 89 96
info@unitemp.com

Romania
Test Line SRL
72217 Bucharest
Tel. (1) 6 87 34 62 
Fax (1) 2 42 68 24
testline@customers.digiro.net

SINGAPORE / MALAYSIA / INDONESIA
Futron Electronics
Singapore 329857 
Tel. (65) 62 50 24 56  
Fax (65) 62 50 65 92
futron@cyberway.com.sg

SLOVAKIA
K - Test s.r.o.
042 60 Kosice
Tel. (1) 55 625 36 33 
Fax (1) 55 625 36 33
ktest@isternet.sk
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SLOVENIA
Tehnounion D.D.
1000 Ljubljana 
Tel. (1) 5 13 50 88 
Fax (1) 5 13 52 96
matjaz.ponikvar@tehnounion.si

SPAIN
Instrumentos Testo S. A.
08348 Cabrils
Tel. (93) 753 95 20 
Fax (93) 753 95 26
info@testo.es

SWEDEN
Nordtec Instrument
40241 Göteborg 
Tel. (31) 704 10 70 
Fax (31) 12 50 42
nordtec@nordtec.se

SWITZERLAND
Testo AG
8604 Volketswil
Tel. (1) 9 08 40 50 
Fax (1) 9 08 40 51
info@testo.ch

SYRIA
Medical Business Center
Damascus
Tel. (11) 2 32 23 01 
Fax (11) 2 31 75 55
bahah@net.sy

TAIWAN, R.O.C.
Hot Instruments Co. Ltd.
Taipei
Tel. (2) 87 32 51 71 
Fax (2) 87 32 51 70
info@testotaiwan.com 

THAILAND
Entech Associate Co. Ltd.
Bangkok 10210
Tel. (2) 9 54 54 99 
Fax (2) 9 54 54 95
info@entech.co.th

TUNISIA
Starepr
Immeuble Mouradi (Touta)
2000 Le Bardo
Tel. (71) 50 92 86, 58 16 68
Fax (1) 58 49 20
afri.sta@gnet.tn

TURKEY
Testo Elektronik ve Test Ölcüm Cihazlari
Dis Ticaret Ltd. STI
80280 Esentepe-Istanbul
Tel. (212) 2 75 77 99 
Fax (212) 2 72 06 13 
info@tetrainc.com.tr

UNITED ARAB EMIRATES
Envirotech General Trading Co.
Ajman
Tel. (14) 2 27 70 20 
Fax (14) 2 23 36 83
Envirote@emirates.net.ae

USA
Testo Inc.
Flanders, NJ. 07836
Tel. (973) 2 52 17 20 
Fax (973) 2 52 17 29
info@testo.com

VENEZUELA
G & M International Service, C. A.
San Antonio de los Altos, Edo.Miranda
Tel. (2) 3 72 77 70 
Fax (245) 57 16 774
gminter@cantv.net

VIETNAM
MTC
Measuring and Testing Equipment
Company Ltd.
Hanoi
Tel. (4) 7 33 36 36
Fax (4) 7 33 21 03
mtc-hn@hn.vnn.vn



Head office / Hauptsitz
Testo AG
Postfach 11 40, D-79849 Lenzkirch 
Testo-Straße 1, D-79853 Lenzkirch

Tel. (0 76 53) 6 81 - 0 
Fax (0 76 53) 6 81 - 1 00

E-Mail: info@testo.de
http://www.testo.de

Kundendienst / Service department
Testo AG
Kolumban-Kayser-Str. 17, D-79853 Lenzkirch

Software-Hotline (0 76 53) 6 81 - 630  
E-Mail: softwarehotline@testo.de

Rauchgas-Hotline (0 76 53) 6 81 - 620
E-Mail: rauchgashotline@testo.de

Klima-Hotline (0 76 53) 6 81 - 610
E-Mail: klimahotline@testo.de

Kaufm. Bearbeitung (0 76 53) 6 81 - 600
E-Mail: kaufmhotline@testo.de

Fax (0 76 53) 6 81 - 601
http://www.testo.de

Kundencenter / Service center
Nord
22457 Hamburg
Tel. (0 40) 55 97 23 - 0
Fax (0 40) 55 97 23 - 50

Außenstelle Bremen
Tel. (04 21) 54 28 15
Fax (04 21) 54 59 37

Außenstelle Hannover
Tel. (0 53 44) 26 15 - 28
Fax (0 53 44) 26 15 - 29

West
42555 Velbert-Langenberg
Tel. (0 20 52) 95 37 - 0
Fax (0 20 52) 95 37 37

Außenstelle Großraum Köln
Tel. (0 65 56) 9 30 53
Fax (0 65 56) 9 30 54

Mitte
65520 Bad Camberg
Tel. (0 64 34) 91 55 - 0
Fax (0 64 34) 91 55 - 70

Außenstelle Mannheim / Heidelberg
Tel. (0 63 21) 60 00 28
Fax (0 63 21) 60 00 29

Südwest
72770 Reutlingen
Tel. (0 71 21) 5 15 38 - 0
Fax (0 71 21) 5 15 38 - 20

Südost
90455 Nürnberg
Tel. (09 11) 46 25 88 30
Fax (09 11) 46 25 88 40

Außenstelle Regensburg
Tel. (0 94 03) 96 18 10
Fax (0 94 03) 96 18 11 

Außenstelle München
Tel. (0 89) 4 70 95 94
Fax (0 89) 4 70 95 92

Nordost
13409 Berlin
Tel. (0 30) 4 96 40 46
Fax (0 30) 4 96 50 44

Außenstelle Großheringen
Tel. (03 64 61) 2 07 93
Fax (03 64 61) 2 07 99

0973.0431/T/wh/PC_qxd/01.02
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